Credits

Inspiration® is designed, developed, and marketed by Inspiration Software®, Inc.

Original Creators  Don Helfgott and Mona Westhaver

Product Management  Peggy MacDonald, Jonathan Maier, Clara Steiner-Jay

Systems Analyst  Jack Bennett, Yuvi Zalkow

Programming Management  Sid Snyder, Jason Stafford

Technical Lead  Michael Fawver, John Shankland

Programming  Steve Bernard, Brian Fagerberg, Mark Fornia, Dave Goldman, Craig Kemper, Keith Miller, Daniel Pool, Wyatt Webb, Peter Wong

Information Technology Support  Jon Fronza, Greg Watson

Quality Assurance Managers  Richard Stone, Sue Williamson

Quality Assurance Lead  Jon Barwise, Ken Rueckert, Kim Russell

Quality Assurance Staff  Jon Barwise, Jeff Lowell, Kim Russell, April Schuff, Russ Van Rooy, Geoffrey Unger

Testers  Elizabeth Butcher, Chris Charles, Clayton Hanson, Wade Jackson, Mauricio Machado, Laura McLane, Keith Miller, Janet Redhawk, Gina Shankland, Tony Vu, Eric West

Templates & Examples  Mary Chase, Bob Madar, Caren Normandin, Lori Deuchar Yum

Interface & Symbols  Linnea Johnsson, Adrian Quan

Training Videos  Glenn Green, Megan Murphy

Help System  Adrian Quan, Rebecca Rudd

Prior Contributors  Rob Clarke, John Cromett, Bruce Hoof, Mark Oronzio, Samson Tong

© 2006 Inspiration Software, Inc. All rights reserved. Inspiration®, Inspiration Software®, Kidspiration®, RapidFire® and Site Skeleton® are registered trademarks of Inspiration Software, Inc. The Inspiration design mark is a trademark of Inspiration Software, Inc.

QuickTime® is a registered trademark of Apple Computer, Inc.

Portions Copyright ©1990-94 Halcyon Software. All rights reserved. The Sentry Spelling-Checker Engine Copyright ©1993-1998 Wintertree Software Inc.

Other brands and trademarks are the property of their respective owners.

Inspiration supports creation of mind maps by applying mind mapping techniques developed by Tony Buzan and others. Inspiration Software, Inc. is not affiliated with Tony Buzan, Buzan Ltd. or Buzan Centres Inc.
# Table of Contents

## Chapter 1: Getting Started .................................................................5

- Where to find more information .......................................................... 5
- What's great in Inspiration 8! ................................................................. 6
- Installing Inspiration .............................................................................. 12
  - About upgrading from an earlier version of Inspiration ...................... 13
  - Windows installation ........................................................................... 13
  - Macintosh installation ......................................................................... 14
  - Network installation ............................................................................ 14
- Viewing and printing Inspiration documentation .................................. 15
- Removing Inspiration ............................................................................ 15
- Registering Inspiration .......................................................................... 16
- Customer service .................................................................................... 16

## Chapter 2: Introducing Inspiration ..................................................17

- About the Inspiration Views .................................................................... 17
  - Diagram View ..................................................................................... 18
  - Map View .......................................................................................... 19
  - Outline View ..................................................................................... 20
- Uses of graphic organisers ....................................................................... 20
- Uses of outlines ..................................................................................... 26
- Starting Inspiration ................................................................................ 27

## Chapter 3: Learning Inspiration, A Tutorial ..............................28

- Lesson One: Introduction to Diagram View .......................................... 29
  - Start Inspiration .................................................................................. 30
  - Start a new diagram ............................................................................ 30
  - Enter a main idea ................................................................................ 31
  - Add ideas quickly using the RapidFire® tool ....................................... 31
  - Point and type to add an unconnected symbol ................................... 34
  - Use the Create tool to add a linked symbol ....................................... 35
  - Search for a symbol ............................................................................ 35
  - Browse the symbol libraries ............................................................... 36
  - Connect ideas using the Link tool ...................................................... 39
  - Label the connections between ideas ............................................... 40
  - Add a note to a symbol ....................................................................... 41
  - Move a note ....................................................................................... 41
  - Save a document ................................................................................ 42
  - Quit Inspiration .................................................................................. 42
- Lesson Two: Introduction to Outline View .......................................... 43
  - Switch from Diagram View to Outline View ....................................... 44
  - Add a topic ........................................................................................ 45
Add a subtopic ...................................................................................................................... 46
Move a topic by dragging ....................................................................................................... 47
Change the level of a topic ..................................................................................................... 48
Hide and show subtopics ....................................................................................................... 48
Add a note ............................................................................................................................... 49
Set topic defaults ................................................................................................................... 49
Change topic prefixes ........................................................................................................... 50

Lesson Three: Advanced Diagram View ................................................................................ 51
Switch from Outline View to Diagram View ........................................................................... 52
Set symbol defaults ................................................................................................................ 53
Change note colours .............................................................................................................. 54
Arrange a diagram using the Arrange tool ........................................................................... 55
Control the arrangement of a diagram using AutoArrange ................................................... 56
Change the view scale ......................................................................................................... 57
Insert a hyperlink .................................................................................................................. 58
Record a sound ..................................................................................................................... 58
Create a video symbol ......................................................................................................... 59
Print your document ........................................................................................................... 60
Transfer to a word processor ............................................................................................... 61
Export your document .......................................................................................................... 61

Lesson Four: Create a mind map ............................................................................................ 62
Start a new mind map .......................................................................................................... 62
Enter a central idea ................................................................................................................ 63
Add branch text .................................................................................................................... 63
Use the Add Topic Quick Control to add a topic .................................................................. 63
Add subtopics with the RapidFire Tool ................................................................................ 65
Point and type to add a detached topic ............................................................................... 66
Rearrange topics and branches ........................................................................................... 67
Move topics and branches to a different branch ................................................................... 67

Lesson Five: Enhance a mind map ....................................................................................... 69
Change the colour of branches and text ............................................................................... 69
Add symbols to topics ......................................................................................................... 70
Connect ideas using the Relationship tool .......................................................................... 71
Add a label to a relationship link ......................................................................................... 72
Adjust a relationship link .................................................................................................... 73
Add a note ............................................................................................................................. 73
Switch from Map View to Outline View ............................................................................... 74

Other inspiring resources .................................................................................................... 75
Training videos ....................................................................................................................... 75
Online Help ............................................................................................................................ 75
Inspiration User’s Manual ..................................................................................................... 75

Inspiration Software, Inc. Licence Agreement ....................................................................... 76

Index .................................................................................................................................... 78
Chapter 1: Getting Started

Powered by the proven strategies of visual learning, Inspiration® 8 is the essential tool used by students of multiple learning styles. Inspiration supports the most highly effective visual learning environments for organising ideas graphically with diagrams, outlines and now mind maps. Using Inspiration 8, students develop critical thinking, planning and organisational skills for lifelong learning and achievement.

This guide is designed to help you get started using Inspiration. It contains:

- What's great in Inspiration 8!
- System requirements
- Installation instructions
- Customer service information
- Introduction to Inspiration
- Tutorial

Where to find more information

The Inspiration Help system contains detailed information about using Inspiration commands and features. The Inspiration User's Manual is available as a PDF and contains all the information in the Help system.

- To access the Help system while you are using Inspiration, choose Help on the Help menu.
- To view or print the Inspiration User's Manual, see “Viewing and printing Inspiration documentation” on page 15.
- Inspiration Technical Support is available online. To connect to Technical Support while you are using Inspiration, on the Help menu select Online Technical Support.
What's great in Inspiration 8!

Inspiration includes the following new features and enhancements:

**More ways to engage and learn visually**

**Map View.** With Inspiration's new mind mapping capabilities, you follow the familiar process of building a mind map to visually represent an entire concept or idea with branches of associated thoughts.

**Searchable symbols.** Quickly find symbols to better express ideas and represent concepts by searching with keywords. Inspiration provides more than 1,000 symbols, plus access to more than one million additional symbols through Inspiration Web Resources.

To find a symbol, enter keywords in the box at the bottom of the Symbol palette, then click Q. Inspiration searches both the built-in symbol libraries and the online symbol collection, then displays the search results in the palette.

**Video and sound integration.** You can now insert and play multimedia, such as QuickTime® movies and MP3s, to create more engaging and informative projects.

- **Video**

  Enhance your diagrams and mind maps with videos created in other programs. You can integrate video by creating custom video symbols.

  Click on your diagram or mind map to select where you wish to insert a video file. On the Tools menu, point to Insert Video or Sound, then select Video. The first frame of the video is visible. To play the video, click the Video button ⚡.

- **Sound**

  To attach an audio file to a symbol or topic, point to Insert Video or Sound, then select Sound File. To play the attached sound, click the Audio Quick Control ⏯️.
Jumpstart projects and research with ease

**Starter screen.** Begin projects quickly from the new Inspiration Starter screen. Create a new diagram, mind map or outline, continue work on a recent file or jumpstart any assignment with one of 60+ templates. You can also explore "how to" videos by selecting Learn to Use.

**More inspiring templates.** Start projects quickly with templates that offer frameworks for gathering information and organising ideas. Choose from 60+ templates that cover English, science, humanities, thinking skills and planning topics.

When creating templates with the Template Wizard, you can limit symbol libraries to focus learning. And, custom libraries can now be distributed with any template!

**Powerful drag and drop capabilities.** Inspiration 8 introduces familiar drag and drop actions that make research a snap. Quickly move text, images, video and sound files from other sources into your Inspiration projects. Drag and drop URLs—or files from your desktop—to create hyperlinks to important reference materials.
**Write with more clarity and accuracy**

**Innovative Word Guide.** The Word Guide helps you select words with precision while building vocabulary. This integrated dictionary and thesaurus links synonyms to specific definitions so word choices can be made with greater understanding.

To look up a word, select it and click the Word Guide button on the Main toolbar.

**Auto spell check.** Auto spell check streamlines the revision process by identifying misspelled words in the context of your document. A dashed red line designates misspellings, which are easily corrected with a single click.

**More transfer options.** When you're ready to finalise a written project, the new Transfer tool options allow you to move just the information you need to your preferred word processor. For instance, transfer notes only, with no indention, to ready a report for finalisation.

To select transfer options, click the Transfer button on the Main toolbar.
Inspiration Web Resources

Use Inspiration with an Internet connection to seamlessly access these additional complimentary resources:

**More than one million symbols.** Students better demonstrate their understanding and communicate their ideas by including symbols in their projects. An online Inspiration symbol collection, containing more than one million illustrations and photographs, offers safe image choices for any topic.

**On-demand training videos.** Learn how to use Inspiration and complete projects efficiently with on-demand training videos. These online videos cover Inspiration’s most commonly used features.

And more . . .

**Arranges and changes.** Organising your diagrams just got easier! Select an arrange style in one step with the new Arrange Options button on the Main toolbar, or click the Arrange button to open the enhanced Arrange dialog. Redesigned for greater clarity, the dialog provides more layout options and a preview window to guide your choices.

- **AutoArrange**

  Now you can effortlessly maintain the structure of your diagram and keep your ideas organised. AutoArrange automatically incorporates linked symbols into your chosen arrange style. Simply click the Arrange Options button on the Main toolbar, then select AutoArrange.

  Note that when AutoArrange is on you can continue to move symbols to change their order of position.
• **Split Tree arrange**

Choose the Split Tree arrange to organise your diagram across a left-right axis. To apply this arrange style, click the Arrange Options button, then select Split Tree.

**RapidFire® Options.** Use the RapidFire Without Links tool in diagrams or the RapidFire Detached tool in mind maps when you want to brainstorm ideas first and create relationships later. To add a series of unconnected symbols, click the RapidFire Options button and make your selection.

![RapidFire Options](image)

**New Template Wizard functions.** The Template Wizard in Diagram View introduces a number of new options to customise the learning experience.

- **Template description**

  On the first screen of the Template Wizard, you can enter a brief description to help students understand a template's purpose and use.

- **Limit symbol libraries**

  Limit which symbol libraries are available for a specific project in order to remove distractions and focus learning. You can even limit access to the online symbol collection.

- **Save custom libraries**

  Enrich your templates with tailor-made symbols libraries. Custom libraries can now travel with a template, eliminating the need to load the libraries on each computer.

**Export enhancements.** All export types are now gathered in one convenient Export dialog. Each screen includes a preview window which clearly illustrates your options.
Among the new features:

- The Site Skeleton® export includes symbol images, automatically adding visual elements to your web pages.
- The HTML exports create links to your multimedia files.
- Additional options in the word processor export let you save just the information you need.

To export your work, select Export on the File menu.

**Smart Checklist.** Let Inspiration take care of tracking your progress when you use checklists. Turn Smart Checklist on—now when you check a topic, all of its subtopics are automatically checked; check all of the subtopics beneath a topic and the topic is checked. To use Smart Checklist, on the Tools menu make sure Show Checklist is on, then select Smart Checklist.

**Note resize button.** Can't see all the text in a note? Too much wasted space? Simply click the Resize button and the note will automatically size to fit the text.

![Note resize button](image)

**Fit to Window button.** See all of your diagram or mind map at the click of a button. The Fit to Window button adjusts the zoom so it fits on the screen.

![Fit to Window button](image)

**Expanded Formatting toolbar.** Inspiration 8 puts more tools at your fingertips! Change link style, arrow direction and line thickness using handy controls on the Formatting toolbar.
Installing Inspiration

Before installing Inspiration, make sure your computer meets the following minimum requirements:

**System requirements**

**Windows®**

- Pentium 75 MHz or higher
- Windows 95, 98, 2000, NT 4.0, ME or XP (including Tablet PC Edition)
  (Windows 95 requires Internet Explorer 4 and Windows Socket 2 Update. NT 4.0 requires Internet Explorer 4.)
- 8 MB RAM
- 18 MB available hard drive; 60 MB for full install

  **Recommended:**
  - Internet connection
  - QuickTime®
  - 800x600 display

  **Optional:**
  - Stylus-based systems (electronic whiteboards, Wacom tablets, Tablet PCs)
  - Microphone
  - Printer

**Macintosh®**

- OS X (10.1.5 or higher)
- 70 MB available hard drive
- QuickTime

  **Recommended:**
  - Internet connection
  - 800x600 display

  **Optional:**
  - Stylus-based systems (electronic whiteboards, Wacom tablets, Tablet PCs)
  - Microphone
  - Printer
About upgrading from an earlier version of Inspiration

When you install Inspiration 8, it does not overwrite any earlier version of Inspiration installed on your computer. This enables you to keep custom templates and custom symbol libraries created in the earlier version of Inspiration.

After you install Inspiration 8, you can copy custom templates and symbol libraries from the earlier version to the Templates and Libraries folders within the Inspiration 8 folder.

Copy individual symbol libraries to the Custom Libraries folder, located in the Libraries folder. Copy templates from the earlier version of Inspiration to the Templates folder inside the Inspiration 8 folder.

Copy templates from the earlier version of Inspiration to the Templates folder inside the Inspiration 8 folder. After you copy the templates and libraries you want to keep, you can remove the earlier version of Inspiration from your computer.

Any files you created using Inspiration 6 or Inspiration 7 can be opened by Inspiration 8.

Windows installation

1. Close all programs, including screen saver and anti-virus programs.
2. Insert the Inspiration CD-ROM into your CD-ROM drive.
3. Double-click My Computer, then double-click the icon for your CD-ROM drive.
4. Double-click the Install.exe icon, then choose an install location.
5. Select Easy Install to install the full Inspiration program, including symbols, templates, examples and the Help system.
   --or--
   Select Minimum Install to install the application and the minimum number of components required to run the program. Choose this option if you have limited hard disk space and you do not want to install the full Inspiration program.
6. Follow the instructions on your screen to complete the installation process. A message appears when installation is complete.

   If necessary, the installer will add the required text-to-speech software to your computer. Click OK to install.
The installer will also inform you if QuickTime, or an update, is needed. QuickTime enables Inspiration’s multimedia capabilities. Click OK to view a web page that will help you download this free software.

After completing these additional installations, you can choose to restart your computer now or later.

7. Inspiration starts automatically and the Personalise Inspiration dialog appears.

8. Enter your name and/or organisation and your serial number.

*Note:* Your serial number can be found on the CD-ROM sleeve. The serial number identifies your copy of Inspiration; it is required to personalise your Inspiration application. Click OK.

To register your copy of Inspiration, see “Registering Inspiration” on page 16.

**Macintosh installation**

1. Close all programs, including screen saver and anti-virus programs.

2. Insert the Inspiration CD-ROM into your CD-ROM drive.

3. Drag the Inspiration 8 IE folder to your Applications folder.

4. Double-click the Inspiration application icon to start Inspiration.

The Personalise Inspiration dialog appears.

5. Enter your name and/or organisation and your serial number.

*Note:* Your serial number can be found on the CD-ROM sleeve. The serial number identifies your copy of Inspiration; it is required to personalise your Inspiration application. Click OK.

To register your copy of Inspiration, see “Registering Inspiration” on page 16.

**Network installation**

Refer to the network installation instructions provided with your volume licence. Volume licences are available from Inspiration Software, Inc. For more information, call +1 503-297-3004.
Viewing and printing Inspiration documentation

The *Inspiration User’s Manual* and other written documentation is available in the form of PDF files. To view or print this information, you need Adobe® Acrobat® Reader installed on your computer. If your computer does not have Acrobat Reader, you can download a free copy from Adobe at www.adobe.com.

**To view or print Inspiration documentation:**

1. Start Inspiration.
2. On the Inspiration Starter screen, click the Learn to Use button.
3. Double-click the Inspiration Documentation folder to open. The folder contains three documents:
   - *Getting Started.pdf* *(Getting Started Guide, including installation instructions and tutorial)*
   - *Registration.pdf* *(Inspiration Registration Form)*
4. Double-click the a PDF to view or print.

Removing Inspiration

**Windows**

1. Click the Start button, point to Settings, then click Control Panel.
2. Double-click Add/Remove Programs.
3. Select Inspiration 8 IE in the list box, then click Add/Remove.

**Macintosh**

- Drag the Inspiration 8 IE folder to the Trash, then empty the Trash.
Registering Inspiration

To register a single copy of Inspiration, click Register Online after you personalise Inspiration. Your browser starts and opens Inspiration’s online registration form. Follow the on-screen instructions. (Note: You must have Internet access and a browser installed to register online.)

If you are unable to register online, please complete and fax or mail the registration form included in the Inspiration documentation folder. For more information, see “Viewing and printing Inspiration documentation” on page 15.

To register a volume licence, please complete and mail or fax the printed licence agreement.

When you register, you’re entitled to special benefits from Inspiration Software, Inc. As a registered customer, you receive:

- Telephone, fax and email technical support
- Substantial discounts on Inspiration upgrades
- Tips on using Inspiration
- Information about new products or updates
- Flashes, the Inspiration Software, Inc. email newsletter

Customer service

Inspiration Software, Inc. is committed to assisting our customers. If you have comments, questions or need assistance while working with Inspiration, you can contact us by email, telephone or fax. You can also connect directly to Inspiration Technical Support by choosing Online Technical Support on the Help menu.

Inspiration Software, Inc. provides customer service and technical support for registered users. Be sure to register so you can take advantage of our support services.

When you contact us, please be ready to provide your serial number. Our support services are open Monday-Friday from 8 a.m. to 5 p.m. Pacific time.

Telephone  +1 503-297-3004
Fax          +1 503-297-4676
Email        techsupport@inspiration.com
Chapter 2: Introducing Inspiration

In Inspiration you think and learn visually. Inspiration allows you to create a picture of your ideas and concepts in the form of a diagram or mind map. It also provides an integrated outlining environment for developing your ideas into organised written documents. Inspiration stimulates both visual and linear thinking to deepen understanding of concepts, increase memory retention, develop organisational skills and tap creativity.

When you work with visual representations of ideas, you easily see how one idea relates to the others. Learning and thinking become active rather than passive. You discover where your deepest knowledge lies and where the gaps in your understanding exist. When you create a visual map of ideas, you recall details better than if you had simply read a paragraph—that’s because you can see it in your mind.

If you have an idea that you want to expand, whether it’s an idea for a written document or for mapping out a plan, Inspiration can help you organise your thoughts and save you time. You can create a diagram or mind map to work through your ideas, arrange them and group them to clarify your thinking.

When you’re ready to structure your ideas, you can use Outline View to organise your ideas hierarchically. Inspiration’s outlining environment is perfect for adding structure to written documents, reports and plans.

About the Inspiration Views

Inspiration has three views or environments: Diagram View, Map View and Outline View. As you work in a diagram or mind map, changes will be automatically reflected in the integrated outline. Sometimes you will work exclusively in Diagram View or Map View to create a graphic organiser or a map showing how ideas or concepts relate. Other times you will work in Outline View where you might organise and write a report.
**Diagram View**

You can use Diagram View to create a diagram that shows the relationship between ideas or concepts.

Here's what Diagram View looks like:
Map View

You can use Map View to create a mind map, building branches of associated topics around a central idea.

Here's what Map View looks like:
Outline View

You can use Outline View to create an outline of your ideas or to organise and write a report.

Here's what Outline View looks like:

![Outline View diagram]

Uses of graphic organisers

In Inspiration you can create many types of graphic organisers. It doesn't matter if you're comparing literary novels, looking at cause and effect or developing your understanding of a complex concept. The kind of diagram or mind map you create in Inspiration depends on the idea you want to develop. The following are some of the different types of graphic organisers you can easily build using Inspiration.
**Concept map**

A concept map is a hierarchical diagram used to represent a set of concepts beginning with the most general or most important and then working down to more specific detail. Key concepts are connected by links that have descriptive words on them explaining the relationship between the concepts.

Concept maps are often used to illustrate scientific or historical concepts or for other types of knowledge mapping.

The *Skin* diagram is an example of a concept map.
**Idea map**

You can use an idea map to brainstorm ideas and develop thoughts. An idea map starts with a main idea or problem in the middle of the screen. You record ideas associated with the main idea in symbols that radiate out from the main idea. The symbols connect to the main idea with links. Subtopics or specific details are then added to those ideas. You let the ideas flow and then step back and look at main themes, patterns or possible solutions.

Idea maps can be used for individual or group brainstorming, planning, problem solving and report writing.

The *Blue* diagram is an example of an idea map.
**Mind map**

A mind map is a hierarchical diagram with a central idea, or image, at the centre of the map surrounded by branches that extend from the central idea. Inspiration mind maps follow the techniques developed by Tony Buzan and others. Mind map branches contain supporting ideas, or topics with higher level topics closest to the central idea.

Mind mapping provides a powerful framework to help organise and recall information whilst allowing for easy editing.

*Student Portfolio* is an example of a mind map.
**Web**

A web is a visual map that shows how different bits of information relate to each other. A web has a main idea or core concept at the centre, with different categories of information connected to it. Ideas, facts and information are connected to the categories to support them.

Webbing is particularly useful when you're analysing a story or brainstorming ideas for a plan or written report.

The *Hatchet* diagram is an example of a web.
**Storyboard**

A storyboard is a visual way to organise projects such as multimedia presentations or the design of a web page. A storyboard helps you plan what you're going to say and show, and figure out which ideas belong at the beginning, middle and end. In a storyboard, each symbol can represent a different slide, screen or page.

*The Science Fair Web Site Plan diagram is an example of a storyboard.*
# Uses of outlines

When you make an outline, you create a hierarchical structure for your ideas. An outline helps you organise written documents, speeches or plans by providing a framework for your ideas and by letting you order the flow of information.

You will find outlining particularly useful for planning and structuring information when writing. While the structure of an outline is simple, outlines can help you organise very complex material.

## Outlining

### I. Definition

An outline is like a jigsaw puzzle; you are working to fit pieces of information together into a cohesive picture.

- **A. Summary or synopsis of information**
- **B. An organisational pattern or schematic summary of ideas**

### II. Hierarchical form

- **A. Supporting details are arranged beneath more important ideas**
  - 1. See relationships among ideas
  - 2. Ideas are more supportive in nature as outline branches out

- **B. Display organisation of ideas**
  - 1. Show areas where you need additional details to support main topics
  - 2. Point out areas which have too much emphasis and need to be trimmed to avoid imbalance
  - 3. Make clear what information is not relevant to your topic

### III. Uses

- **A. Map out chronology**
- **B. Show cause and effect relationships**
- **C. Clarify processes**
- **D. Expound logic**
Starting Inspiration

After you have your copy of Inspiration installed and personalised, you're ready to get to work. Here's how you open Inspiration.

**To start Inspiration on a computer running Windows:**

- Click the **Start** button, point to **Programs**, then click **Inspiration 8 IE**.

**To start Inspiration on a Macintosh computer:**

- Open the folder that contains Inspiration, then double-click the Inspiration icon.
Chapter 3: Learning Inspiration, A Tutorial

This tutorial is a great starting point for learning how to use Inspiration. Please plan on 45-60 minutes from start to finish.

If you’re new to Inspiration and like to learn while working on screen, this tutorial is for you. We have kept the information in small, manageable chunks to make it easy to learn the basics quickly. Before you know it, you’ll be using Inspiration to develop your own great ideas!

You use Inspiration the same way as most Mac OS and Windows programs. For example, you use the mouse to drag objects and to select text. You also click and double-click, as well as enter information using the keyboard. If you’re not comfortable doing these things, take a moment now and refer to the user’s guide that came with your computer.

Conventions we use

The tutorial has instructions for both Mac OS and Windows-based computers. When you’re asked to press a key or click a command on a menu, the Mac OS instructions appear first, and the Windows instructions are in parentheses immediately afterward. Here are two examples: Press Return (Enter) and press the Command (Ctrl) key.

When you’re asked to enter specific text, the text you type appears in bold. For example, The Enlightenment. When referring to a symbol or name you already entered, it appears in italics, like The Enlightenment.

And a special note . . . Because people work in different ways, Inspiration offers many ways to do things—from toolbar buttons to menu commands to keyboard shortcuts. While these options are all readily available, this tutorial usually shows one way to do a task. By limiting the alternatives presented, we hope to make it easier to learn the task. In the Help system and the Inspiration User’s Manual, you will find many ways to do each task so you can pick the one that’s most comfortable for you. To access the Help system, see “Where to find more information” on page 5. To view or print the Inspiration User’s Manual, see “Viewing and printing Inspiration documentation” on page 15.
How we organised the tutorial

In the Inspiration tutorial, you will follow a series of straightforward, step-by-step instructions to create a simple visual representation of an idea called a diagram. You also work with an outline: a text-based, hierarchical display of the same idea. Finally, you will create a mind map to visually represent a concept with branches of associated thoughts.

The tutorial is organised into five lessons. They're designed to be completed in order, but you don't need to do them all at one time. Each lesson introduces you to a set of the unique features in Inspiration. When you finish the tutorial, you'll be ready to create diagrams, mind maps and outlines on your own.

Lesson One: Introduction to Diagram View

In this lesson, you'll create a diagram about the Enlightenment period using symbols, links and notes. You'll learn to do the following:

- Start Inspiration
- Start a new diagram
- Enter a main idea
- Add ideas quickly using the RapidFire tool
- Point and type to add an unconnected symbol
- Use the Create tool to add a linked symbol
- Search for a symbol
- Browse symbol libraries
- Connect ideas using the Link tool
- Label the connections between ideas
- Add a note to a symbol
- Move a note
- Save a document
- Quit Inspiration
Start Inspiration

Note: Before you can start the program, Inspiration needs to be installed. If you haven’t installed Inspiration on your computer yet, see “Installing Inspiration” on page 12.

To start Inspiration on a computer running Windows

- Click the Start button, point to Programs, then click Inspiration 8 IE.

  The Inspiration Starter opens.

To start Inspiration on a Macintosh computer

- Open the Inspiration 8 IE folder, then double-click the Inspiration icon.

  The Inspiration Starter opens.

Start a new diagram

From the Inspiration Starter you can quickly begin a new project, open existing documents and access the many different Inspiration templates. You can also open any of the resources, including examples and training videos, provided to help you learn and use Inspiration.
You'll begin this tutorial by starting a new diagram.

- To start a new diagram, click the Create a diagram button.

A new document opens with the Main Idea symbol centred on screen.

**Enter a main idea**

The Main Idea symbol provides a starting point for your work. It's easy to get started—just type!

- Type the diagram topic, The Enlightenment, into the Main Idea symbol.

Now you're ready to add topics that expand or explain your main idea.

**Add ideas quickly using the RapidFire tool**

The RapidFire tool allows you to add a series of ideas that are connected to a symbol (RapidFire With Links option) or to add a series of unconnected ideas (RapidFire Without Links option). When you use the RapidFire tool, you can concentrate on adding ideas rather than creating symbols one at a time.

The RapidFire tool places information in a freeform structure. There's no need to think about organising yet; you're still getting ideas down to "see" what you think. You'll learn more about organising the information later in this tutorial.

First, you'll add linked symbols to your main idea.

1. Select The Enlightenment if it's not already selected. On the Main toolbar, click the RapidFire button.

   A red lightning bolt appears in the symbol to show that the RapidFire tool is turned on.

2. Type Scientific Discoveries and press Return (Enter).
3. Type Inventions and press Return (Enter).
4. Type Political Events and press Return (Enter).
5. Type Arts.
6. Click the RapidFire button again to turn the RapidFire tool off.
You'll notice there's now a Subtopic Quick Control near the upper right corner of *The Enlightenment*.

The Subtopic Quick Control appears next to a symbol to show that it has a subtopic. Clicking the Subtopic Quick Control will hide and show the subtopics.

Here's what the diagram looks like now.

![Diagram](image)

Now use the RapidFire tool again, this time adding a series of unconnected ideas.

1. Select *The Enlightenment* if it's not already selected. On the Main toolbar, click the RapidFire Options button. Select Without Links.

   ![RapidFire Options](image)

   Again, a red lightning bolt appears in the symbol to show that the RapidFire tool is turned on.

2. Type **Law of Gravity** and press Return (Enter).
3. Type **Steam Engine** and press Return (Enter).
4. Type **American Revolution**.
5. Click the RapidFire button to turn the RapidFire tool off.
Here's what the diagram looks like now.

*Tip:* If you made a mistake while entering text into a symbol, don't worry. Simply double-click the text in the symbol. Then select the words to change and type over them. You can also insert text by clicking where you want to make a correction and entering the new text.
**Point and type to add an unconnected symbol**

Pointing and typing anywhere on the workspace is another quick way to add an unlinked idea. When you type, a new symbol is automatically created.

1. Click in the open area of the diagram above *Arts*.
2. Type *Montesquieu*.

Here's what the diagram looks like now.
Use the Create tool to add a linked symbol

To add a linked symbol in any direction, use the Create tool.

1. Select Political Events. On the Main toolbar, position the cursor over the middle left point on the Create button.

![Create tool](image)

When you roll over a point on the Create button, it highlights to show the direction in which the new symbol will be created.

2. Click the middle left point. A new symbol appears connected to and directly left of Political Events. This symbol is selected and ready for you to enter an idea.

3. Type French Revolution into the new symbol.

Search for a symbol

Inspiration provides a wide variety of pictures and images to represent concepts and ideas. In the built-in libraries, you'll find more than 1,000 symbols organised into curriculum-based categories. In addition to the libraries that come with Inspiration, the program offers an online collection of more than one million images.

Inspiration's search function makes finding just the right image a snap. When you search for symbols, Inspiration searches both the Inspiration libraries on your computer and the online collection.

*Note:* The Online Access option is selected by default. To turn Online Access off, select Preferences in the Utility menu, then click the Online Access tick box.

1. Select French Revolution if it's not already selected.

2. In the box at the bottom of the Symbol palette, type the words French and flag.

3. Click the Find button  

   Inspiration searches for all images containing your keywords.

4. Click one of the images that appear. Since it was selected, the French Revolution symbol automatically changes to your selection.
Here's what the diagram looks like now.

**Browse the symbol libraries**

You can also browse Inspiration's built-in libraries to see a variety of symbols within a specific category. To scroll through Inspiration's built-in libraries one by one, use the Next Library or Previous Library buttons on the Symbol palette.

1. Select the *Arts* symbol.
2. On the Symbol palette, click the Libraries tab.
3. Click the Next Library button eleven times. The Art tools library should be visible.
4. Click on the *Palette*. 

*Arts* automatically changes to the shape of this palette.

You may want to reposition *Arts* to make more of the link visible. Inspiration makes it easy move symbols—you just click and drag them anywhere on the workspace. When you move a symbol, any links automatically adjust.

- With *Arts* still selected, drag the symbol down so your diagram looks like the one below.
You can also use drag and drop to add a symbol from the Symbol palette to represent a new idea. This time, you'll click the Select Library button to jump right to your chosen library. The Select Library button offers a category list of all of Inspiration's built-in symbols.

1. Click the Select Library button. Navigate to the Food-Health category, and choose the Health library.

2. Drag the Glasses symbol until it is positioned to the left of Inventions and release the mouse button.

When you add a symbol using drag and drop, it is not connected to any other symbols.
**Connect ideas using the Link tool**

Links show the relationships and connections between ideas. When you use the RapidFire With Links tool or the Create tool, your ideas are automatically linked. You can also create links.

1. Select *Political Events*. This is the symbol where the link will start.
2. On the Main toolbar, click the Link button to turn on the Link tool.

   ![Link button](image)

   The cursor now looks like this.

3. Click *American Revolution*. This is the symbol where the link will end.

   A link with the arrowhead pointing to the *American Revolution* symbol appears.

4. Click *American Revolution* again.

5. Now click *Montesquieu*.

   A second link appears and the arrowhead points to the *Montesquieu* symbol.

6. Continue to link symbols together. Click on the first symbol and then the symbol where you want the link to end.

   - Link *Scientific Discoveries* to *Law of Gravity*.
   - Link *Inventions* to *Steam Engine*.
   - Finally, link *Inventions* to *Glasses*.

7. Click the Link button again to turn off the Link tool.
Here's what the diagram looks like now.

**Label the connections between ideas**

Each link has a text box that appears when the link is selected. Adding text to this box defines the relationship between the symbols.

1. Select the link between *Inventions* and *Glasses* if it's not already selected.

   When a link is selected, you see the outline of the text box associated with that link. It's ready for you to enter text.

2. Type **bifocals**.
Add a note to a symbol

A note is available for each symbol in a diagram. Notes allow you to expand ideas and actually begin the writing process while continuing to work in a visual format.

1. Select Montesquieu. On the Main toolbar, click the Note button.

   ![Note]

   A note opens below the symbol.

2. Type Montesquieu's work influenced the writing of constitutions in many countries, including the United States.

Move a note

After you add a note to a symbol, it's easy to move the note to another location on the symbol, or to any open place in the workspace.

1. Click the note title bar to select the open note.

2. Drag the note to the lower right side of Montesquieu.

Here's what the diagram looks like now.
Save a document

Whenever you're working on a document, it's a good idea to save it on a regular basis. To save a document for the first time, or to save a document you've already saved using the current file name, use the Save command.

1. On the File menu, choose Save.
2. If necessary, select the folder in which you want to save the document.
3. Click Save.

Note: All Inspiration documents are automatically saved with an ISF extension.

Quit Inspiration

If you're ready to take a break from the tutorial, you can quit Inspiration after saving your changes. If you want to continue, just skip this procedure and turn to the next lesson.

1. To close your file and quit Inspiration, on the File menu, choose Quit (Exit).
   If you've made changes to the document, Inspiration prompts you to save those changes.
2. Click Yes to save your changes and quit Inspiration. You can start again with the next lesson.
Lesson Two: Introduction to Outline View

Inspiration's diagramming environment is fully integrated with the outline environment. While you've been creating a web of your ideas in Diagram View, Inspiration has also been working behind the scenes, building an outline of your work.

You can always begin a new outline from scratch by clicking the Create an outline button on the Inspiration Starter. For this lesson though, open the diagram created in the previous lesson by clicking the Open a file button.
Working in Outline View, you'll learn to do the following:

- Switch from Diagram View to Outline View
- Add a topic
- Add a subtopic
- Organise topics
- Move a topic by dragging
- Change the level of a topic
- Hide and show subtopics
- Add a note
- Hide and show a note
- Set topic defaults
- Change topic prefixes

**Switch from Diagram View to Outline View**

When you switch to Outline View, your information is instantly displayed in a traditional hierarchy.

1. Select *The Enlightenment*.
2. To view your information in Outline View, click the Outline button on the Main toolbar.

The diagram is transformed into an outline. The symbols now appear as topics and subtopics, and the notes text is visible. Even though you did not name the *Glasses* symbol in Diagram View, the Picture-to-Topic option automatically provided a label for the topic to ensure you didn't lose the relationship between ideas when you switched views.
Here's what the outline looks like now.

**Add a topic**

Topics are the core ideas in your outline. You can add a new topic in Outline View as easily as you added a new symbol in Diagram View.

1. Select *Political Events* by clicking in the Selection control column.
   
   A selection box appears around the topic to show it's selected.

2. On the Main toolbar, click the Topic button.

   ![Topic](image)

   Inspiration inserts a new topic and automatically assigns it a prefix. The cursor moves to the new line so you're ready to enter text for your new idea.

3. Type *Influential People*. 
Add a subtopic

In the same way you added a new topic, you can add new subtopics. These ideas provide information subordinate or supplemental to a topic.

1. With *Influential People* selected, click the Subtopic button on the Main toolbar.

   ![Subtopic button](image)

   When you add a subtopic, Inspiration automatically indents it one level below the selected topic and assigns it a prefix. The cursor also moves to the new line so you can enter text for the new idea.

2. Type *Voltaire*.

Here's what the outline looks like now.
Move a topic by dragging

There are many ways to organise your outline. The most direct is simply dragging a topic up or down in the outline. Any subtopics associated with this topic move too.

1. Select Montesquieu.

2. Drag the topic so it is positioned directly below Voltaire. Release the mouse button.

While you drag, the topic remains in its original position until you release the mouse button. You can tell where the topic's new location will be by watching the gray line as you drag. The small highlighted dot indicates the indentation level of the topic's new location.

Montesquieu now appears as a subtopic of Influential People, at the same level as Voltaire.

Here's what the outline looks like now.
**Change the level of a topic**

To move a topic to a lower level in the outline, drag it to the right or use the Right tool to move it down in the hierarchy.

1. Select *Inventions*.
2. On the Main toolbar, click the Right button.

![Right button]

The *Inventions* topic and its subtopics move to the right and are now subtopics of *Scientific Discoveries*.

Here's what this section of the outline looks like now.

![Outline screenshot]

**Hide and show subtopics**

When working with a complex outline, it's often useful to hide subtopics so you can concentrate on the main topics.

1. Click the Subtopic Quick Control to the left of *Scientific Discoveries*. The subtopics for this topic are now hidden.
2. Click the Subtopic Quick Control again to show the subtopics.
Add a note

Notes text is a good way to further develop ideas in Outline View. You can add anything from one sentence to multiple paragraphs to several pages of text.

1. Select Glasses.

2. On the Main toolbar, click the Note button.

   The cursor moves to a new line so you can enter the notes text.

3. Type Benjamin Franklin invented bifocals in the 1700s. He was tired of switching between two pairs of glasses.

   When you add a note, a Note Quick Control appears in the Note control column to the left of the topic. The Note Quick Control indicates that the topic's note is either hidden or showing.

Set topic defaults

To clearly define the structure of your outline, you can set the defaults for any or all topic levels and notes. Default options include font, text size, text colour and other style choices.

1. Select The Enlightenment.

2. On the Formatting toolbar, click the Topic Defaults button. The Topic Defaults dialog box appears.

3. Select Level 1 and change the colour to dark green. Click Preview.

4. Select a new font. Click OK.
Here's what the outline looks like now.

![Outline Example]

**Change topic prefixes**

Inspiration offers a variety of prefix styles you can use in your outline.

1. On the Formatting toolbar, click the Prefix button.
2. Select a new prefix style.
   
   All of the prefixes in the outline are changed to reflect your selection.

**Taking a break**

If you're ready to take a break from the tutorial, save your changes and quit Inspiration. If you want to continue, just skip this procedure and turn to the next lesson.
Lesson Three: Advanced Diagram View

Since the diagram and outline views are fully integrated, when you return to Diagram View, you see the diagram has changed to reflect the work done in Outline View.

In this lesson, you complete your diagram as you learn to do these things:

- Switch from Outline View to Diagram View
- Set symbol defaults
- Change note colours
- Arrange a diagram using the Arrange tool
- Control the arrangement of a diagram using AutoArrange
- Change the view scale
- Insert a hyperlink
- Record a sound
- Create a video symbol
- Print your document
- Transfer to a word processor
- Export diagrams and outlines
Switch from Outline View to Diagram View

1. Select *The Enlightenment* if it's not already selected.
2. To view your information in Diagram View, click the Diagram button on the Main toolbar.

The outline is transformed into a diagram.

Here's what the diagram looks like now, including the work done in Outline View.
Set symbol defaults

Changing the defaults for symbols allows you to quickly create multiple symbols with the same characteristics.

1. Select Political Events.

2. On the Formatting toolbar, click the Fill Colour button. Select a light colour from the palette.

![Click the Fill Colour button to choose a colour.](image)

The colour inside the symbol changes to reflect your selection.

3. On the Symbol palette, click on the basic rounded rectangle shape that appears at the top of the palette. The Political Events symbol now looks something like this.

![Political Events](image)

4. With Political Events still selected, on the Formatting toolbar, click the Defaults button. Choose Set Default.

5. Now select Influential People and Scientific Discoveries—the other basic symbols at the same level as Political Events.

Tip: To select more than one item, press the Shift key and click each item.

6. Click the Defaults button, then choose Apply Default.

These symbols now exhibit the same formatting as the Political Events symbol. Any new symbols added to the diagram will also have these same characteristics.

Note: You can also use the Topic Defaults tool to set defaults for links and notes.
Here's what the diagram looks like now.

**Change note colours**

Note colours are also changeable, so you can customise them to match symbols.

1. Select *Glasses*. Click the Note Quick Control.

   The note opens.

2. On the Formatting toolbar, click the Line Colour button and choose a light blue colour from the palette. This will change the colour around the note.
**Arrange a diagram using the Arrange tool**

The Arrange tool changes a freeform diagram into a more structured layout. You can apply one of three basic arrangements to a diagram, then make refinements using the Arrange options.

1. Select *The Enlightenment*.
2. On the Main toolbar, click the Arrange button. The Arrange dialog box appears.
3. Select Tree.
4. Click the More Options button.
5. In the Links box, choose Straight.
6. Click OK.

The diagram automatically rearranges into the new format.

Here's what the diagram looks like now.
Control the arrangement of a diagram using AutoArrange

AutoArrange makes it easy to maintain the structure of your diagram. As you work, AutoArrange continuously arranges any linked symbols you add to your project.

1. On the Main toolbar, click the Arrange Options button. Select AutoArrange from the drop-down list.

Note that this drop-down list also offers quick access to Inspiration's basic arrangement styles.

2. Select The Enlightenment if it's not already selected.

3. Now you'll add two new topics. Click the RapidFire Options button on the Main toolbar, and select With Links. The red lightning bolt tells you the RapidFire tool is turned on.

4. Type Daily Life and press Return (Enter).

5. Type Exploration.

6. Click the RapidFire button again to turn the RapidFire tool off.

Your new symbols are automatically incorporated into the diagram arrangement.

*Note:* When AutoArrange is on, you can continue to move symbols to change their order of position.
Here's what your diagram looks like now.

**Change the view scale**

Magnifying and reducing the view allows you to work with specific parts of your diagram or outline, or to see the entire screen at one time. To see more of the diagram or outline in the window, you zoom out. To make symbols or topics look bigger, you zoom in. You can also zoom in or out to a specific percentage.

1. To the left of the bottom Scroll bar, click the Zoom In button several times. This makes your diagram appear larger on the screen.

2. If you'd like the diagram to appear smaller on screen, click the Zoom Out button.

3. To size your diagram to fit nicely on screen, click the Fit to Window button.
**Insert a hyperlink**

You can further enhance a project by integrating resources from the Internet. You can also hyperlink directly to a document created in Inspiration or another application.

1. Select the words "American Revolution."
2. On the Main toolbar, click the Hyperlink button.

The Hyperlink dialog appears.


The selected text appears in the Hyperlink Text box.

4. In the Link To box, type [www.americaslibrary.gov](http://www.americaslibrary.gov). Click OK. This creates a hyperlink to a Library of Congress web page.

*Note:* You can also simply drag and drop or copy and paste a URL or file from your computer's desktop onto your diagram.

**Record a sound**

You can also annotate diagrams, mind maps and outlines with recorded comments.

*Note:* To record sounds, Record Sound must be made available in Preferences, and your computer must have a microphone. You will find Preferences on the Utility menu.

1. Select *Voltaire*.
2. On the Tools menu, point to Insert Video or Sound, and then click Record Sound.
3. In the recording control box, click Record to begin recording.

4. Say “I disapprove of what you say, but I will defend to the death your right to say it. ~Voltaire”

5. When you finish recording, click Save.

The Audio Quick Control is now displayed next to the Voltaire symbol. Click the Audio Quick Control to play your recorded sound.

Create a video symbol

You can add video to diagrams and mind maps for research and reports, planning multimedia projects and creating more dynamic presentations. You can even make a video a symbol in your diagram.

*Note:* To insert and play a video, your computer must have QuickTime. To install QuickTime, choose Get QuickTime on the Inspiration Help menu.


2. On the Tools menu, point to Insert Video or Sound, and then select Video.

3. Navigate to the Inspiration 8 IE folder on your hard drive. Select the Tutorial Support folder and open Isaac_Newton.mov.

The first frame of the video is now the image for the Law of Gravity symbol. Click the Video button to play the video.

*Note:* You can also simply drag and drop or copy and paste a video file onto your diagram.
Here's how the diagram looks now.

---

**Print your document**

Before you print your project, you can determine layout, margins, headers and footers, etc., by selecting Page Setup on the File menu. Page Setup also allows you to preview the diagram, mind map or outline before printing and—once you're ready—to print.

2. Make your selections and choose Print Preview to preview your work.
3. Click Print.

*Note:* If you're creating a bulletin board or other display, you can scale your work to fill a specified number of pages.
**Transfer to a word processor**

When you are ready to finalise your work for publication, you can easily transfer it to a word processor. The Transfer tool automatically launches Microsoft® Word or Appleworks®.

1. Click the Transfer button on the Main toolbar.

   ![Transfer button](image)

   The Transfer Options dialog appears.

2. Select your preferred options and click OK.

   Inspiration automatically launches your preferred word processor and transfers your work.

*Note:* In some cases, it may be advantageous to simply transfer your notes. Using this option, each note becomes a separate paragraph, making it easy to finalise your paper or report.

**Export your document**

Diagrams, mind maps and outlines can be exported for use in a variety of other programs.

- On the File menu, choose Export and make your selections.

You're finished creating your Enlightenment project. Please save your changes before continuing on to lessons four and five.
Lesson Four: Create a mind map

Inspiration’s mind map environment allows you to create a mind map using the techniques developed by Tony Buzan and others. Many of the same features found in Diagram View are available when creating a mind map. We will review some of these commonly used features in the mind map lessons; however, we recommend you review topics covered in the previous lessons for additional details.

In this lesson, you’ll learn to do the following:

- Start a new mind map
- Enter a central idea
- Add branch text
- Use the Add Topic Quick Control to add a topic
- Add subtopics using the RapidFire tool
- Point and type to add detached topic
- Rearrange topics and branches
- Move topics and branches to a different branch

Start a new mind map

You’ll begin this lesson by creating a new mind map document.

To start a new mind map, click the Create a mind map button.

A new document opens with the Central Idea symbol centred on the screen and four starter branches.
Enter a central idea

The *Central Idea* symbol provides a starting point for your work. Just enter an idea to get started!

- Type *Effects of Global Warming* into the *Central Idea* symbol.

Add branch text

Now you're ready to add topics that expand or explain your main idea.

1. Select the blue branch in the upper left and type *ecosystems*.
2. Select the orange branch in the upper right and type *droughts and floods*.
3. Select the purple branch in the lower right and type *agriculture*.
4. Select the red branch in the lower left and type *weather*.

Here’s what your mind map looks like now.

![Mind map](image)

*Note:* To wrap text, press Return (Enter) between words.

Use the Add Topic Quick Control to add a topic

You can add subtopics to expand on your ideas. The Add Topic Quick Control adds a linked subtopic in one click.

1. Select *ecosystems*.
2. Click the Add Topic Quick Control at the end of the *ecosystems* branch.
3. Type *coral reefs*. 
Here’s what your mind map looks like now.

Note: If you select ecosystems, you'll notice there's now a Subtopic Quick Control near the upper right corner of the topic. The Subtopic Quick Control appears next to a topic to show that it has a subtopic. Click the Subtopic Quick Control to hide and show the subtopics.

You can also add a new branch off the Central Idea symbol using the Add Topic Quick Control.

1. Select Effects of Global Warming.
   
   Add Topic Quick Controls appear on either side of the central idea and at every junction of the branches.

2. Click the Add Topic Quick Control on the left side of Effects of Global Warming. A new branch appears. The topic is selected and ready for you to enter text.

3. Type sea levels into the new topic.
Here’s what your mind map looks like now.

![Mind Map Image]

**Add subtopics with the RapidFire Tool**

The RapidFire tool allows you to quickly add a series of ideas to your map. When you use the RapidFire tool, you can concentrate on adding information rather than creating new branches or topics. You can choose to add attached or detached topics.

1. Select *sea levels* if it's not already selected.
2. Click the RapidFire Options button. Select Attached.

![RapidFire Options Button]

A red lightning bolt appears in the topic text area to show that the RapidFire tool is turned on.

3. Type *land loss* and press Return (Enter).
4. Type *flooding* and press Return (Enter).
5. Type *saltwater intrusion*.
6. Click on the RapidFire button again to turn the RapidFire tool off.
Here’s what your mind map looks like now.

![Mind Map Image]

**Point and type to add a detached topic**

Another easy way to capture your ideas is to just point and type anywhere on the workspace. When you type, a new topic is automatically created.

1. Click on an open area of the mind map.
2. Type *melting glaciers*.

*Tip:* Deleting topics and branches is easy. Just select a topic and press Delete or Backspace. The selected topic and all associated subtopics will be deleted. To delete a single topic in the middle of a branch, select the topic, go to the Branch menu and then select Delete topic only. Keep in mind that you cannot delete the Central Idea.
Rearrange topics and branches

There are many ways to organise your mind map. One way is to drag a branch or topic anywhere on the workspace. When you drag a branch, it moves as a single unit. When you drag a topic, any subtopics associated with the topic move as well.

1. Select sea levels.

2. Drag the topic to the upper right of the mind map. When the branch passes the Central Idea, the subtopics flip to the other side.

Move topics and branches to a different branch

Topics can also be moved from one branch to another by dragging. As the dragged topic or branch passes directly over another topic, a highlight indicates where it will be attached when you release the mouse button. If you continue to drag beyond the topic, the highlight disappears.

1. Select droughts and floods and drag it over weather. Release the mouse button when you see the highlight.

   Droughts and floods becomes a subtopic of weather and inherits the formatting characteristics of weather.

2. Select melting glaciers. Drag it over weather and release the mouse button.
Here’s what your mind map looks like now.

Tip: Magnifying and reducing the view allows you to work with specific parts of your mind map, or to see the entire mind map on your screen. The Zoom controls are found to the left of the bottom Scroll bar.

Taking a break
If you’re ready to take a break from the tutorial, save your changes and quit Inspiration. If you want to continue, just skip this procedure and turn to the next lesson.
Lesson Five: Enhance a mind map

In this second mind mapping lesson, you will continue to work with the document created in the previous lesson and use colour and images to customise your work and make it compelling and memorable. You will learn to do the following:

- Change the colour of branches and text
- Add a symbol to a topic
- Connect ideas using the Relationship tool
- Add a label to a relationship link
- Adjust a relationship link
- Add a note

Change the colour of branches and text

Colour is a great way to enhance and customise the look of your mind map.

1. Open the document you saved in the previous lesson if it’s not already open.
2. Select sea levels. The entire branch is highlighted.
3. On the Formatting toolbar, click the Line Colour button. Select a bright blue colour from the palette. The entire branch changes to reflect your selection.
4. Now click the Text Colour button on the Formatting toolbar and select the same blue colour so the text matches the branch.
Add symbols to topics

Inspiration offers a wide variety of pictures and images to represent concepts and ideas. In the built-in libraries, you'll find more than 1,000 symbols organised into curriculum-based categories. In addition to the libraries that come with Inspiration, the program offers an online collection of more than one million images.

Inspiration's search function makes finding just the right image a snap. When you search for symbols, Inspiration searches both the Inspiration libraries on your computer and the online collection.

*Note:* The Online Access option is selected by default. To turn Online Access off, select Preferences in the Utility menu, then click the Online Access tick box.

1. Select *coral reefs*.
2. In the box at the bottom of the Symbol palette, type the words *coral* and *reef*.
3. Click the Find button Q.

   Inspiration searches for all images containing your keywords.

4. Click one of the images that appear. Since *coral reefs* was selected, the image is automatically added above this branch text.

Here’s what your mind map looks like now.

![Mind map with coral reefs added](image)

You can also browse Inspiration’s symbol libraries to see a variety of images within a specific category. To scroll through Inspiration's built-in libraries one by one, use the Next Library or Previous Library buttons. You can also use the Select Library button to jump right to your chosen library.
1. On the Symbol palette, select the Libraries tab.

2. Click the Select Library button. Navigate to the Everyday category, and choose the Community library.

3. Drag the Farm symbol until it is positioned over agriculture. When you see a highlight, release the mouse button. The symbol appears above the text.

Here’s what your mind map looks like now.

Tip: To delete a symbol from a topic, select the topic. On the Effect menu, choose Symbol, and then select Remove.

**Connect ideas using the Relationship tool**

Using relationship links, you can indicate a connection between two topics on your mind map. The topics can be detached, on the same branch or on two separate branches.

1. Select agriculture if it’s not already selected. This is the topic from which the relationship link will start.

2. On the Main toolbar, click the Relate button to turn on the Relationship tool.

   ![Relate](image)

   The cursor now looks like this.

3. Click weather. This is the topic where the relationship link will end.

4. Click the Relate button again to turn off the Relationship tool.
Here’s what your mind map looks like now.

Add a label to a relationship link

Each relationship link has a text box that appears when it is selected. Adding text to this box defines the relationship between the topics.

1. Select the relationship link between *agriculture* and *weather* if it's not already selected.

   When a relationship link is selected, you see the outline of the text box associated with that link.

2. Type *depends on*.
**Adjust a relationship link**

You can easily change the connection points of a relationship link by dragging the handle at either end of the link to a new location. You can also change the direction of the curve by adjusting the link’s resize handles.

- Play with these tools to adjust the relationship link between agriculture and weather.

*Tip:* You can move the text on a relationship link by dragging the round selection handle on the text box.

**Add a note**

A note can be added to any topic in a mind map. Notes allow you to expand ideas and begin the writing process while continuing to work in a visual format.

1. Select *agriculture*. On the Main toolbar, click the Note button.

   A note opens below the topic.

2. Type **Fluctuations in weather patterns could have a significant impact on agricultural production.**
Switch from Map View to Outline View

You can easily create an outline from your mind map by switching to Outline View. In Outline View, your information is displayed in a traditional hierarchy. The two views are fully integrated; any changes made in one are automatically made in the other.

- To view your information in Outline View, click the Outline button on the Main toolbar.

The mind map is transformed into an outline. As discussed in the previous lessons, in Outline View you can add and organise topics and subtopics, add notes, set defaults, change prefix styles and more.

Here's what your outline looks like.

Congratulations! You've finished creating your Effects of Global Warming project. If you’d like to return to your mind map, simply click the Map button on the Main toolbar.
Other inspiring resources

To learn more about using Inspiration, check out these inspiring resources.

Training videos

Inspiration includes access to online training videos that show how to do specific tasks using Inspiration, including creating symbol libraries, using templates and more.

Note: To view a video, your computer must have QuickTime. To install QuickTime, choose Get QuickTime on the Inspiration Help menu.

1. On the Inspiration Starter, click Learn to Use.

2. Double-click Training Videos to see the list of available videos.

3. Select a video title in the list, then click Open.

Online Help

The Inspiration Help system contains detailed information about how to use Inspiration, including special features, tools and commands.

- To open the Help file, choose Inspiration Help on the Help menu. If the Help system is not available, you must install it using the Inspiration CD-ROM.

Inspiration User’s Manual

The Inspiration User’s Manual contains all the information in the Help system. The manual is available as a PDF file, which you can view and print using Adobe Acrobat Reader.


Note: If your computer does not have Acrobat Reader, you can download a free copy from Adobe at www.adobe.com.
Inspiration® Getting Started Guide

Inspiration Software, Inc. Licence Agreement

IMPORTANT -- PLEASE READ THIS LICENCE AGREEMENT CAREFULLY BEFORE OPENING THE SOFTWARE PACKAGE:

In this Agreement, “Software” means the computer program and software known as Inspiration® Version 8. “You” or “your” means the end user and licencsee of the Software pursuant to this Agreement. “Inspiration Software” means Inspiration Software, Inc., an Oregon corporation.

TERMS OF AGREEMENT: When you open the package containing the CD-ROM disk on which the Software is installed, you agree to be bound by the terms and conditions of this Agreement and at that time the grant of the licence described below will be effective. If you do not agree to be so bound, promptly return the unopened Software package and all contents to the place of purchase for a full refund of the amount you paid for this Software licence.

GRANT OF LICENCE FOR USE ON ONE COMPUTER: Inspiration Software grants to you a nonexclusive licence to use the Software on the temporary memory, hard drive or other storage device of one computer. You must purchase a licence for each additional computer on which the Software is installed or can be used. If the Software is installed on a computer which is usable by multiple work stations or on multiple computers connected by a network, you must purchase licences for each computer that can access or use the Software.

Notwithstanding anything herein to the contrary, your use of all or a portion of Software content accessible via the Internet (as described below), may (and the licence for your use thereof granted by this Agreement revoked), in whole or in part, by Inspiration Software, or its successors or assigns, at any time after July 31, 2010.

PROPRIETARY RIGHT: All rights in and to the Software (including but not limited to any images, photographs, animations, video, audio, music, text, examples, templates, symbols and software modules incorporated into the Software) are owned or licensed by Inspiration Software and are protected by law, including without limitation, U.S. and international copyright laws and international trade provisions. You acknowledge the ownership, validity and enforceability in all aspects of all rights, including patent, copyright and trademark rights, that Inspiration Software has in the Software. You will not participate in any attack on the validity or enforceability of Inspiration Software’s above-described rights whether in court, the United States Patent and Trademark Office, the U.S. Copyright Office, or elsewhere, or otherwise contest Inspiration Software’s above-described rights. It is in the intent of Inspiration Software and you that this paragraph shall have claim and issue preclusive effect. You agree that the nature and quality of the Software will conform to standards set by Inspiration Software and otherwise be under the control of Inspiration Software.

You will not use the Software for any purpose other than as expressly provided in this Agreement, including without limitation, any unauthorized copying or distribution of, or other act with respect to the Software, that would violate any law. You may not modify, reverse engineer, decompile, disassemble, create derivative works, or otherwise change the whole or any part of the Software, nor may you deliver copies to, or sell, rent, lease, loan or sublicense the Software to any third party (other than as expressly provided in this Agreement).

You may transfer the Software installed on the enclosed CD-ROM disk along with the accompanying written materials to a recipient, but only if you retain no copies thereof and the recipient agrees to the terms of this Agreement.
LIMITED WARRANTY: Inspiration Software warrants that the CD-ROM disk on which any portion of the Software is recorded will be free of defects in materials and workmanship under normal use for ninety (90) days after the original purchase. If a defect occurs during such ninety (90) day period, you may return the CD-ROM disk to Inspiration Software for free replacement. Inspiration Software will replace the CD-ROM disk, provided that you have previously properly filled out, executed and returned the registration card accompanying the Software to Inspiration Software. Any replacement Software CD-ROM disk will be warranted for the remainder of the original warranty period or 30-days, whichever is greater; provided, however, that this replacement warranty is not available, nor will it be provided by Inspiration Software, outside of the United States of America. Inspiration Software disclaims all other warranties, either express or implied, including but not limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the Software. In no event will Inspiration Software be liable to you for damages, whether based on contract, tort, warranty or other legal or equitable basis, including any loss of profits, loss of business, cost savings or other indirect, special, incidental or consequential damages arising out of or related to the Software, even if Inspiration Software, or an authorized representative of Inspiration Software, has been advised of the possibility of such damages. Subject to the foregoing, certain Software content may be available for use on your computer only through computer download via computer Internet access. You understand that the operability and functionality of the Software may be dependent upon your computer’s performance capabilities, its capacity to access the Internet and the operability of computer servers or Internet web sites on which Software content may be stored or from which Software content may be accessed. Without limiting any other matter contained herein, Inspiration Software does not warrant or represent that the Software will meet your requirements or that the operation of the Software will be uninterrupted or error-free. You bear all risk of loss for computer, Software or other malfunctions arising from access to or use of the Internet. The remedies set forth in this Agreement shall be your sole and exclusive remedies for any breach of this Agreement by Inspiration Software.

GENERAL: All notices under this Agreement will be transmitted between the parties at the addresses identified above, or as otherwise designated by written notice from either party to the other. This Agreement contains the entire understanding between the parties regarding the subject matter of this Agreement, superseding all prior or contemporaneous communications, agreements and understandings between you and Inspiration Software. This Agreement is binding on and inures to the benefit of the parties, their legal representatives, successors and assigns; provided, however, that except as otherwise provided herein, neither this Agreement, nor any rights granted hereunder, may be assigned, transferred, conveyed or encumbered by you without the prior written consent of Inspiration Software. This Agreement will be construed in accordance with the internal laws (and not the law of conflicts) of the state of Oregon, and it may be amended only in writing and signed by duly authorized representatives of both parties. If any provision or clause of this Agreement, or any portion thereof, is held by any court or other tribunal of competent jurisdiction to be illegal, void or unenforceable in such jurisdiction, the remainder of such provisions shall not thereby be affected and shall be given full effect, without regard to the invalid portion. This Agreement is neither intended to, nor shall it be construed as creating, a joint venture, partnership or other form of business association between the parties. If any suit or action is filed by any party to enforce this Agreement or otherwise with respect to the subject matter of this Agreement, the prevailing party shall be entitled to recover reasonable attorney fees incurred in preparation or in prosecution or defense of such suit or action as fixed by the trial court, and if any appeal is taken from the decision of the trial court, reasonable attorney fees as fixed by the appellate court. If you are a U.S. Government user, then the Software is provided with “RESTRICTED RIGHTS” as set forth in subparagraphs (c)(1) and (c)(2) of the Commercial Computer Software-Restricted Rights clause at FAR 52.277-19.
Index

A
Add Topic Quick Control • 63
Adding hyperlinks • 58
Adding ideas to mind map
  using Add Topic Quick Control • 
  63
  using point and type • 66
  using RapidFire tool • 65
Adding linked symbols to diagram • 35
Adding notes
  to a diagram • 41
  to a mind map • 73
  to an outline • 49
Adding notes text • 41, 73
Adding subtopics to outline • 46
Adding symbols to diagram
  using Create tool • 35
  using point and type • 34
  using RapidFire tool • 31
Adding text to link • 40, 72
Adding topics to outline • 45
Arranging diagrams
  arrange tool • 55
  AutoArrange • 9, 56
  split tree arrange • 10
Arrow direction button • 11
Audio
  adding to document • 6
  quick control • 58
  recording sound • 58
Auto Spell Check • 8
AutoArrange • 9

C
Central idea • 63
Changing the view scale • 57
Changing topic level in outline • 48
Checklist
  Smart Checklist • 11
Colours
  branches in mind map • 69
  notes in diagram • 54
  symbols in diagram • 53
Compatibility with Inspiration 6 and 7 • 13

Connecting ideas in diagram • 39
Conventions • 28
Create tool • 35
Custom symbol libraries • 13
Custom templates • 13
Customer service • 16

D
Defaults
  symbols in diagram • 53
  topics in outline • 49
Diagram View • 18, 51
  switching to • 52
  tools • 18
Diagrams
  adding notes • 41
  adding symbols • 31, 34, 35
  arranging • 55, 56
  exporting • 61
  printing • 60
  starting • 30
  transferring to word processor • 61
Documentation • 5
  online Help • 75
  user's manual • 75
  viewing and printing • 15
Documents
  exporting • 10, 61
  saving • 42
  transferring to word processor • 61
Dragging and dropping • 7
  branches in mind map • 67
  topics in outline • 47

E
Entering Central Idea • 63
Examples
  mind map • 23
Exporting documents • 10, 61

F
Fill colour tool • 53, 54
Fitting diagrams into window • 12

H
Help • 75
Hiding notes text • 49
Hiding subtopics in outline • 48
Hyperlinks • 58
I
Inserting hyperlinks • 58
Inspiration
compatibility with Inspiration 6 and 7 • 13
documentation • 5
quitting • 42
removing • 15
starting • 27, 30
Inspiration Starter • 30, 62
Installing Inspiration
Macintosh • 14
network • 14
system requirements • 12
upgrading from earlier version • 13
Windows • 13
Internet hyperlinks • 58

L
Learning Inspiration • 75
Line thickness button • 11
Link style button • 11
Link tool • 39
Links
adding text • 40
arrow direction • 11
creating using the Link tool • 39
relationship links • 71, 72, 73
style • 11

M
Map View
adding subtopics • 63
adding symbols to topics • 70
changing the colour of branches • 69
mind maps
adding notes • 73
moving and attaching branches • 67
relationship link • 71, 72, 73
Moving notes in diagram • 41
Moving topics in mind map • 67
Moving topics in outline • 47

N
New features • 6
Notes
adding to diagram • 41
adding to mind map • 73
adding to outline • 49
changing colours in diagram • 54
moving in diagram • 41
optimising size • 11

O
Online Help • 75
Optimising note size • 11
Outline View • 20, 43
switching to • 44
tools • 20
Outlines
adding notes • 49
adding subtopics • 46
adding topics • 45
changing prefixes • 50
exporting • 61
moving topics • 47
printing • 60
setting topic defaults • 49
showing and hiding subtopics • 48
transferring to word processor • 61

P
Picture-to-Topic • 44
Pointing and typing to add ideas • 34, 66
Prefixes • 50
Printing
documentation • 15
documents • 60

Q
Quitting Inspiration • 42

R
RapidFire tool
adding ideas to diagram • 31, 65
adding topics to mind map • 65
without links option • 10, 31, 65
Recording sound • 58
Registering Inspiration • 16
Relate tool • 71
Removing Inspiration • 15
S

Saving documents • 42
Searching for symbols • 6, 35
Setting defaults
topics in outline • 49
Setting symbol defaults in diagram • 53
Showing and hiding subtopics in
outline • 48
Smart Checklist • 11
Sound recording • 58
Spelling checker
Auto Spell Check • 8
Starting Inspiration • 27, 30
Subtopics
adding to mind map • 63, 65
adding to outline • 46
changing level in outline • 48
showing and hiding in outline • 48
Symbol libraries
custom • 13
Symbols
adding notes • 41
searching for • 6, 35
setting defaults in diagram • 53
video • 59
System requirements • 12

T

Template Wizard
entering template description • 10
limiting symbol libraries • 10
saving custom libraries with
documents • 10
Templates
custom • 13
Text
adding to branch • 63
adding to link • 39
adding to note • 41, 49
adding to symbol • 31, 34
adding to topic • 45
Topics
adding mind map • 63
adding to outline • 45
changing level in outline • 48
changing prefixes • 50
moving in mind map • 67
moving in outline • 47

setting defaults in outline • 49
Training videos • 9, 75
Transferring documents to word processor • 61
Tutorial
conventions • 28

U

Upgrading from earlier version of Inspiration • 13

V

Video
creating video symbols • 6, 59
training videos • 9, 75
Views
Diagram View • 18
Map View • 19
Outline View • 20, 43
switching to Diagram View from
Outline View • 44
switching to Outline View from
Map View • 74
views
switching to Outline View from
Diagram View • 52

W

Windows • 13
Word Guide • 8
Word processor • 61